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1 About this documentation
1.1 Validity of the documentation

Overview on target groups and
product phases

In the following illustration, the framed activities, product phases and target
groups refer to this documentation.
In the product phase "Engineering", the target group "programmer" can
execute the activities "parameterizing, programming, configuring and simulat‐
ing".
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Fig. 1-1: Assigning this documentation to the target groups, product phases
and target group activities

1.2 Required and supplementing documentation IndraWorks
1.2.1 Engineering

Documentation titles with type codes and part numbers

IndraWorks 14VRS Software Installation
DOK-IWORKS-SOFTINS*V14-CORS-EN-P, R911344286
This documentation describes the IndraWorks installation.
IndraWorks 14VRS Engineering
DOK-IWORKS-ENGINEE*V14-APRS-EN-P, R911343566
This documentation describes the application of IndraWorks in which the Rexroth Engineering tools are integrated. It in‐
cludes instructions on how to work with IndraWorks and how to operate the oscilloscope function.
IndraWorks 14VRS PLC Programming System IndraLogic 2G
DOK-IWORKS-IL2GPRO*V14-APRS-EN-P, R911343571
This documentation describes the PLC programming tool IndraLogic 2G and its use. It includes the basic use, first steps,
visualization, menu items and editors.
IndraWorks 14VRS Basic Libraries IndraLogic 2G
DOK-IL*2G*-BASLIB**V14-LIRS-EN-P, R911343920
This documentation describes the system-comprehensive PLC libraries.
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IndraWorks 14VRS WinStudio 7.4
DOK-IWORKS-WINSTUD*V14-APRS-EN-P, R911341585
This "User Manual and Technical Reference Book" facilitates working with the "Rexroth WinStudio"™ software for optimal
results. This document provides technical information and step-by-step instructions to create web-enabled HMI/SCADA
programs.
Rexroth IndraWorks 13VRS CamBuilder
DOK-IWORKS-CAMBUIL*V13-APRS-EN-P, R911336291
This documentation describes the basic principles and operation of the CamBuilder, the cam editing tool.
IndraWorks 14VRS Field Buses
DOK-IWORKS-FB******V14-APRS-EN-P, R911341485
This documentation describes the field bus and local periphery connections supported by the IndraLogic XLC, IndraMotion
MLC and IndraMotion MTX systems. The focus of this documentation is on the configuration, parameterization, commis‐
sioning and the diagnostics of the different periphery connections.
WebAssistant
DOK-GENERL-WEB*ASSIST*-APRS-EN-P, R911381469
This documentation describes the WebAssistant. The WebAssistant is a webbased diagnostic tool used to access a control
system via an Ethernet highspeed connection. The WebAssistant allows OEMs, end users and service engineers to access
and to remotely diagnose a system. A PC with Internet Explorer version 11 or higher, Firefox version 45 or above or Google
Chrome version 54 or above is required.
The following control variants are supported:
● IndraMotion MLC L25/L45/L65/L75/XM2
● IndraLogic XLC L25/L45/L65/L75/VEP
IndraWorks IndraMotion Service Tool
DOK-IWORKS-IMST*******-APRS-EN-P, R911341383
This documentation describes the IndraMotion Service Tool (IMST). IMST is a web-based diagnostic tool used to access a
control system via an Ethernet high-speed connection. The IMST allows OEMs, end users and service engineers to access
and remotely diagnose a system. The PC has to use at least Internet Explorer 8, Firefox 3.5 or a higher version.
The following control variants are supported:
● IndraMotion MLC L25/L45/L65/L75/XM12/XM2/VPx
● IndraLogic XLC L25/L45/L65/L75
Rexroth IndraDrive Service Tools IMST/IDST
DOK-IM*MLD-IMSTIDSTV13-RERS-EN-P, R911342652
This documentation describes the IndraMotion Service Tools (IMST and IDST). It is a web-based diagnostic tool used to
access a drive system via a high-speed Ethernet connection. Using these service tools OEMs, end users and service engi‐
neers can access and remotely diagnose a system from anywhere.
IndraWorks SafeLogic 14VRS First Steps
DOK-IWORKS-SL*STEP*V14-CORS-EN-P, R911341520
This documentation provides information to facilitate an easy start in the safety control engineering SafeLogic. By using
project examples, information about the installation, configuration, commissioning, troubleshooting and diagnostics is provi‐
ded to the user.
Rexroth IndraWorks 12VRS FDT Container
DOK-IWORKS-FDT*CON*V12-APRS-EN-P, R911334398
This documentation describes the IndraWorks FDT Container functionality. It includes the activation of the functionality in
the project and working with DTMs.
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IndraWorks 14VRS Field Buses Libraries
DOK-IWORKS-FB*LIB**V14-LIRS-EN-P, R911343575
This documentation describes field bus libraries for the IndraLogic XLC, IndraMotion MLC and IndraMotion MTX systems.
IndraWorks 14VRS Remote Support
DOK-IWORKS-REMOTE**V14-APRS-EN-E, R911382628
This documentation supports the user while installing and using a remote support software compatible to the current ope‐
rating systems from Win7 - Win10.
Rexroth IndraWorks Remote Condition Monitoring RMB_TechRCM
DOK-IWORKS-TEC*RCM*V14-LIRS-EN-E, R911343671
This documentation describes the individual functions of the "Remote Condition Monitoring" systems as well as the most
important use cases for a quick status assessment of the connected machines/systems.
IndraWorks 14VRS SafeLogic - Project Configuration, Version 02V08
DOK-IWORKS-SL**PRJ*V14-APRS-EN-P, R911341694
This documentation describes the creation and programming of SafeLogic projects in IndraWorks Engineering.

Tab. 1-1: IndraWorks documentation overview - Engineering

1.2.2 Engineering & visualization
Documentation titles with type codes and part numbers

IndraWorks 14VRS Energy Efficiency Management
DOK-IWORKS-4EE*****V14-APRS-EN-P, R911339229
This document describes the use of the Energy Efficiency Management function within the MLC, XLC and MTX systems.
Using example applications, this documentation provides information about the project planning, configuration and visuali‐
zation of the system.

Tab. 1-2: IndraWorks documentation overview - Engineering & visualization

1.2.3 Visualization
Documentation titles with type codes and part numbers

IndraWorks 14VRS HMI
DOK-IWORKS-HMI*****V14-APRS-EN-P, R911343569
This documentation describes the HMI operating interface IndraWorks Operation, its operation and functions as well as the
configuration in IndraWorks Engineering.

Tab. 1-3: IndraWorks documentation overview - Visualization

1.3 Information representation
1.3.1 Safety instructions

If there are safety instructions in the documentation, they contain certain sig‐
nal words (Danger, Warning, Caution, Notice) and sometimes a safety alert
symbol (according to ANSI Z535.6-2006).
The signal word draws attention to the safety instruction and indicates the
risk potential.
The safety alert symbol (triangular safety reflector with exclamation marks),
preceding the signal words Danger, Warning, Caution indicates hazards for
persons.
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 DANGER

In case of non-compliance with this safety instruction, death or serious injury
will occur.

 WARNING

In case of non-compliance with this safety instruction, death or serious injury
can occur.

 CAUTION

In case of non-compliance with this safety instruction, minor or moderate in‐
jury can occur.

 NOTICE

In case of non-compliance with this safety instruction, material damage can
occur.

1.3.2 Symbols used
Note Notes are represented as follows:

This is a note for the user.

Tip Tips are represented as follows:

This is a tip for the user.

1.3.3 Names and abbreviations
Term Explanation

IWE IndraWorks Engineering

IWO IndraWorks Operation

NC Numerical Control

OEM Original Equipment Manufacturer

VCS Version Control System

Tab. 1-4: Names and abbreviations used

1.4 Customer feedback
Customer requests, comments or suggestions for improvement are of great
importance to us. Please email your feedback on the documentations to
Feedback.Documentation@boschrexroth.de. Directly insert comments in the
electronic PDF document and send the PDF file to Bosch Rexroth.
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2 Important instructions on use
2.1 Intended use
2.1.1 Introduction

Bosch Rexroth products represent state-of-the-art developments and manu‐
facturing. The products are tested prior to delivery to ensure operating safety
and reliability.
The products may only be used as intended. If they are not used as intended,
situations occur that result in damage to property or personal injury due to an
incorrect use of products.

Bosch Rexroth shall not assume any warranty, liability or payment
of damages in case of damage resulting from a non-intended use
of the products; the use shall solely bear all risks from unintended
use of the products.

Before using Rexroth products, ensure that all the prerequisites for an inten‐
ded use of the products are met:
● Anybody dealing with our products is obliged to read and consent to the

relevant safety instructions and the intended use.
● The original condition of hardware products may not be altered; in other

words, no structural modifications are permitted. It is not permitted to
decompile software products or alter source codes.

● Do not install damaged or defective products or commission them.
● It has to be ensured that the products have been installed as described

in the relevant documentation.

2.1.2 Areas of use and application

IndraWorks Engineering is used for configuration, parameterization, program‐
ming and diagnostics.
IndraWorks Engineering is used for selected Bosch Rexroth drive and control
systems.
Additionally, the specifications given in the "Areas of use and application" for
the control and drive systems used with the IndraWorks Engineering do also
apply.

IndraWorks Engineering is designed for a screen setting of 96
DPI. The use of other settings is considered as unintended and
can cause an incomplete or incorrect display of screen elements.

2.1.3 Unintended use
Using IndraWorks Engineering in other applications than those specified or
described in the documentation and technical data is considered as "uninten‐
ded".
Furthermore, IndraWorks Engineering must not be used in any applications
not expressly approved by Bosch Rexroth.
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3 Introduction
3.1 Why Simulation

Due to the increasing stress of competition amongst machine manufacturers,
new possibilities for minimizing the costs of a machine project are sought
continuously. In doing so, all phases of the life cycle of a machine (design,
commissioning, production) are taken into account. Thanks to the more and
more powerful computer systems the concept of simulation is getting more
and more important at this point. The visions even go as far as a virtual
factory, making it possible to emulate all procedures of a production facility in
a virtual manner. One part of this virtual factory is the virtual machine that can
be used to support the individual phases of the life cycle of a machine, using
suitable simulation tools.

3.2 What is being simulated
There are simulation techniques for all phases of the life cycle of a machine.
These simulation techniques are clearly delineated, but have common points,
such as the data acceptance of the design data of the machine from the CAD
system into the 3D visualization.
During the design phase of the machine, the FEM (Finite Elements Method)
analysis or the MBS (Multiple Body Simulation) analysis are used for
example, while the commissioning phase exclusively concentrates on the
behavioral simulation. However, the production phase mostly focuses on the
process optimization (e.g. cycle time optimization).
Considering the simulation techniques during the commissioning phase,
another division of the techniques can be made at this point. On the one
hand, there is the so-called hardware-in-the-loop-simulation, and on the other
hand, there is the software-in-the-loop-simulation.
Hardware-in-the-loop
Regarding this simulation technique, a real control is part of the simulation
set-up. All other components are simulated on one computer or several
computers. The communication connection of the real control to the
simulation components for example is done via Profibus slave cards.
Software-in-the-loop
With this simulation technique, all components are simulated on one
computer or several computers.

3.3 Objectives of Simulation in IndraWorks
The focus of using simulation techniques of the company Bosch Rexroth in
the field of system development for motion control is on optimizing the
commissioning procedure of controls of Bosch Rexroth. This description
primarily describes the functions using the example of the machine tool
control IndraMotion MTX. Basically, the functions can also be used for all
Bosch Rexroth controls. Here, the main focus is on the behavioral simulation,
e.g. on testing the PLC program or the NC program.
In order to meet this objective, components such as a virtual control (NC,
MC, and PLC), a virtual control panel and virtual drives are required. An
efficient behavioral simulation is only allowed for by the interaction of all the
aforementioned components.
Using the following functions the commissioning time can be shortened
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● Testing the complete program sequences in an early phase of
development

● Testing optimized programs before transfer to the machine
● Mixed operation between real and simulated Profibus devices possible
● Can also be used for external controls
● Consistent project states at any time due to IndraWorks project

archiving
However, along with the reduction of the commissioning times there are
further fields of application for the simulation providing the user with cost and
time savings.
● Demonstrator for distribution with the customer
● Testing the program sequences (both of the CNC and the PLC)
● Parameterization of the control and the drives
● Use for training purposes
● Emulation of failures (troubleshooting)
● Validation of troubleshooting measures

3.4 Components in IndraWorks
IndraWorks comprises the following simulation components:
IndraMotion MTX Simulator
The IndraMotion MTX Simulator (see also chapter 5.4  "Virtual control" on
page 18) is a virtual control that can be run on a Windows PC. IndraWorks
Engineering, IndraWorks Operation and the VAM simulator provide a
complete development station for the mechanical engineer.
VAM Simulator
The virtual control panels (see also chapter 5.2  "Virtual control panels" on
page 14) replace the real VAM 40, VAM 41 and an additional control panel,
when working with the MTX Simulator. The optical characteristics and the
function simulate the functions of the real VAM 40 and VAM 41.
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4 Quick start
Different demonstration projects are part of the IndraMotion MTX installation
in the installation directory "..\Rexroth\IndraWorks\Projects". The following
handling instruction describes the configuration steps for these IndraMotion
MTX projects to operate the different simulation components of IndraWorks.
The instructions are not intended for users without any prior knowledge of the
simulation components. Inexperienced users have to read the whole
documentation first, in order to familiarize with the topic.
To execute an IndraMotion MTX project on a PC, simulate the following
steps:

1. Start IndraWorks via the desktop shortcut
2. Load the IndraMotion MTX project (e.g. demonstration project) in

IndraWorks
3. Start the IndraMotion MTX emulation (see also chapter 6.2.5  "Starting

and stopping the MTX emulation" on page 42)
4. Select "local host" for communication of IndraMotion MTX and PLC.
5. The PLC has to be stopped
6. The NC kernel data have to be restored (see also chapter 6.2.3 

"Configuring the NC Kernel" on page 37)
7. The PLC program has to be loaded and started (see also chapter 6.2.4 

"Configuring the PLC" on page 40)
8. Activate the IndraWorks project for IndraWorks Operation (see also

chapter 6.2.2  "Configuring the HMI" on page 35)
9. Create and configure a virtual control panel (e.g. VAM 40) in IndraWorks

engineering (see also chapter 6.1.1  "Configuration in IndraWorks" on
page 19)

10. Start windows program "IndraWorks virtual control panel" (see also
chapter 6.1.3  "Start and operation" on page 31)

Detailed information regarding the IndraMotion MTX emulation
can be found in chapter "Virtual commissioning of the MTX" in the
documentation "IndraMotion MTX commissioning".

DOK-IWORKS-SIMU****V14-AP01-EN-P Bosch Rexroth AG 11/53
IndraWorks 14VRS Simulation

Quick start



Bosch Rexroth AG  DOK-IWORKS-SIMU****V14-AP01-EN-P12/53
IndraWorks 14VRS Simulation



5 Simulation components
5.1 Project Explorer

The simulation components can be found in the IndraWorks Project Explorer
below the Simulation and 3D visualization node.

Fig. 5-1: Project Explorer
Project node Simulation The project node simulation can contain the following simulation components:

Virtual control panels
Several virtual control panels (e.g. VAM 40, VAM 41 or freely configurable
control panels) can be managed and configured.
To add a virtual control panel to the IndraWorks project, proceed as follows:
1. Drop a virtual control panel from the category Simulation in the

IndraWorks library on one of the following nodes in the Project Explorer
via Drag-and-drop:
● Project node
● Simulation node
● Virtual control panel node

2. The dialog box Add new element is opened via the context menu
Add... ▶ Add new element of one of the nodes mentioned above.
The virtual control panel can be selected in the category
Simulation ▶ Virtual control panels.

The following menu items are located in the context menu on the node of a
control panel (e.g. VAM40):
● Open

Opens the selected control panel
● Export...

Exports the current configuration of the selected control panel
● Import...

Imports a configuration of the control panel
● Rename

Renames the selected control panel
● Delete

Irrevocably deletes the selected control panel from the IndraWorks
project

● Assign control
Changes the control the control panel has to communicate with.
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If the node Simulation does not yet exist in the IndraWorks
project, it is created automatically when a new virtual control
panel is added to the project.

5.2 Virtual control panels
5.2.1 General description

The virtual control panels replace the real VAM 40, VAM 41, and an
additional control panel, when working with the MTX simulator. The optical
characteristics and the function simulate the functions of the real VAM 40 and
VAM 41. The current version contains the texts for the languages English and
German.

Fig. 5-2: VAM simulator VAM 40

5.2.2 Configurator
General information

The virtual control panels are configured in IndraWorks Engineering.
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Fig. 5-3: Configuration in IndraWorks
Virtual control panels in

IndraWorks project
In the IndraWorks project tree, virtual control panels can be found below the
Simulation / Virtual control panels node.
Double-click on the node or use Open in the context menu to open the editor
to configure a virtual control panel.
An up-to-date representation of the configured control panel can be found in
the upper part of the editor. By selecting a control element, an input mask to
configure the element is opened in the lower editor area.

Upon initial opening of a user-specific control panel, a control
panel without control elements (blank screen) is displayed. The
control elements can be moved from the control panel library to
the control panel using Drag-and-drop.

Configuration pages of the VAM 40 and VAM 41
The configuration page of the

emergency stop
On the emergency stop page, only the PLC variable for later communication
can be created.

The configuration page of the key-
operated switch

On the configuration page of the key-operated switch, the individual switching
positions are labeled and the PLC variables are assigned.

The configuration page of the
overrides

The configuration page of the overrides is for labeling and assigning the PLC
variables.

The configuration page of the key‐
pad

This page assigns the PLC variables and labels the keypads with texts or
pre-configured images. Each individual key can be allocated by entering a
text or by dragging and dropping an image from the symbol list.

The configuration page of the
quick stop module Depending on the selected type (VAM 40 or VAM 41) the

following different functions are available.

Using the configuration page of the quick stop module, select different
settings for both keys:
● Key labeling
● Function

DOK-IWORKS-SIMU****V14-AP01-EN-P Bosch Rexroth AG 15/53
IndraWorks 14VRS Simulation

Simulation components



Since the keys on the real VAM 40 are hardware-wired and the switches
are equipped with normally closed and normally open contacts, these
settings can also be selected.

● Assigning the PLC variables
The configuration page for user-

specific elements
The following elements can be selected from the configuration page for the
eight user-specific elements:
● LED
● Key with LED
● Key without LED
● Switch with 2 positions
● Switch with 3 positions

Middle position does not have any function
These elements can be labeled and assigned to PLC variables.

Since the keys on the real VAM 41 are hardware-wired and the
switches are equipped with normally closed and normally open
contacts, these settings can also be selected.

The configuration pages of the
user-specific control panel

As the freely configurable control panel provides the same elements as VAM
40 or VAM 41, the configuration pages are partially identical regarding
function and haptics. The elements can be taken from the control panel
library and can be positioned on the sheet.

Fig. 5-4: View of the control panel library

After the elements have been placed on the sheet, they can be
moved using the mouse or the arrow keys.

5.2.3 The application
The application is a separate application and controls the PLC program in the
IndraMotion MTX emulation. The application can be started independently of
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IndraWorks Engineering or IndraWorks Operation. Upon the virtual control
panel start, a project has to be selected in which the control panel to be used
is contained.

The control panels communicate directly with the emulation. It is
not necessary to start IndraWorks Operation or IndraWorks
Engineering.

5.3 Library
5.3.1 Simulation components

Find all components of the simulation in the IndraWorks library in the
category Simulation.

Fig. 5-5: IndraWorks library
Use Drag-and-drop to add simulation components to the IndraWorks project.
The library comprises the following categories:
● Virtual control panels

5.3.2 Virtual control panels
The Virtual Control Panels can be found under the Virtual Control Panel
category. Virtual Control Panel entries:
● VAM 40

Virtual control panel based on the real VAM 40
● VAM 41

Virtual control panel based on the real VAM 41
● User-specific Virtual Control Panel
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A user-specific control panel that can be selected from the control
elements of the VAM 40 and VAM 41 control panels according to the
requirements.

5.4 Virtual control
5.4.1 General description

A virtual control is the most important component of the simulation as it
controls the whole process - as does the real control. It contains the same
functionality as the real control and is parameterized, programmed, and
operated the same way. Thus, the mode of operation for the user does not
change when changing over between virtual and real control. Only the
communication parameters of the Engineering interface have to be adjusted.
However, as the virtual control runs on Windows, the only limitation is that it
is not real-time-compatible.
Using the emulation of the machine tool control IndraMotion MTX, Bosch
Rexroth has such a virtual control.
For further information about the IndraMotion MTX emulation, see chapter
6.2  "Using the virtual control" on page 34.
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6 Operation in IndraWorks
6.1 Using the virtual control panel
6.1.1 Configuration in IndraWorks
Configuring the virtual control panel

Creating a virtual control panel
In order to be able to configure a virtual control panel, a project has to be
created in IndraWorks.
A virtual control panel is created in an existing project in IndraWorks via
Project node ▶ right mouse button ▶ Add new element ▶ Virtual control panel
or selected using the library via the tab Simulation ▶ Virtual control panels to
drag it to the project node and drop it there.

Fig. 6-1: Simulation library
Subsequently, the dialogs "Create VAM4x" or "Create virtual control panel"
are displayed. The following settings can be selected:
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Fig. 6-2: Dialog Create new control panel
● Select the control for communication with the selected control panel.
● Create a new virtual control panel.

A new virtual control panel is created by selecting Create new virtual
control panel ▶ OK.

● Create an already configured virtual control panel.
Select the function "Import configuration" and use the button <...> to
select a configured configuration file in the browser. Afterwards, confirm
your selection and acknowledge the dialog "Create new VAM4x" and
"Create virtual control panel " by pressing <OK>.

Subsequently, the selected "VAM" is displayed under Simulation/Virtual
control panels.
By <double-clicking> or right mouse click ▶ Open on the node of the control
panel, the configuration pages open.

Project conversion
If a project of a previous version is opened in IndraWorks, it is automatically
updated in the background.
If the project is from a version < 9 in which a control panel was configured, a
node "Virtual control panels" is created under the "Simulation" node. The
previously configured control panel is located below.

Assigning process variables
Select a process variable in the Process variable window and drag it to the
control panel by holding the left mouse button down and drop it on the
selected entry.
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If the Process variables is hidden, it can be shown in the main
menu using the menu item View.

Compiling a freely configurable control panel
If a freely configurable control panel is opened, an empty page having a
separation line is shown and the control panel library opens simultaneously
parallel to the process variable browser.
In order to design the control panel, the following steps have to be executed:

Fig. 6-3: Configuration of the freely configurable control panel
Retrieve the folders of the control panel library and select an element to be
placed on the control panel. Subsequently, drag this element to the top part
of the blank page using Drag&Drop. The configuration page of the element is
opened to assign the element.

Functions during configuration of
the freely configurable control pan‐

el

● Move element
If an element has been positioned incorrectly, the element can be
moved using the arrow keys or the mouse.

● Delete element
Using the "Del" key or via Element ▶ Right mouse button ▶ Delete
elements can be removed.

● Delete bitmap
The bitmap on the key can be deleted via Element ▶  Right-
click ▶ Delete bitmaps.

The function "Delete bitmap" is not available for all elements!

Configuring the emergency stop
There are two options to assign a PLC variable to the emergency stop.

1. Select a BOOL variable in the process variable window and drag & drop
it to the image of the emergency stop switch in the control panel. After
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dropping the variable, the configuration page of the emergency stop
opens automatically - if it is not already open - and shows the PLC
variables entered in the text field.

2. Select the PLC variable in the process variable browser and drag and
drop it on the configuration page to the edit field.

The "keyswitch" only accepts variables of type "BOOL".

Configuring the key-operated switch
Labeling the key-operated switch By selecting the key-operated switch in the image of the virtual control panel,

the configuration page is opened. The switch positions are labeled in the
individual text fields. The number of characters of the texts is unlimited and
the new label is displayed immediately in the image of the control panel.

Assigning PLC variables There are two options to assign PLC variables
1. Select the PLC variable from the process variable tree and Drag&drop it

to the image of the key-operated switch. Subsequently, a context menu
is opened where selections determine which switch position has to
communicate with the variable. The positions 1 - 4 are assigned from
left to right.

2. Select a PLC variable in the process variable browser and drag and
drop it on the configuration page to the edit field of the PLC variable.

Fig. 6-4: Configuration page of the key-operated switch

The "keyswitch" only accepts variables of type "BOOL".
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Configuring the overrides
Labeling the overrides By selecting one of the overrides in the image of a virtual control panel, the

configuration page is opened. The overrides are labeled in the individual text
fields. The number of characters of the texts is unlimited and the new label is
displayed immediately in the image of the control panel.

Assigning the PLC variables The PLC variables are assigned in two ways as for all other elements:
1. Select the PLC variable from the process variable tree and Drag&drop it

to the image of the override that must assign the variable. The name of
the variable can be seen on the configuration page in the corresponding
text field.

2. Select a BYTE variable in the process variable browser and Drag&drop
it on the configuration page to the edit field of the PLC variable.

The "keyswitch" only accepts variables of type "BOOL".

Configuring the keypads
The configuration page of the keypads is actuated by selecting a key in the
keypad.

In case of the freely configurable control panel, this function has
the elements "Key angular with and without LED".

Assigning text to the keys When labeling the individual key, the desired key has to be selected in the
keypad first. Subsequently, the cursor moves into the text field "Labeling the
key" and can be used for entering a text.

Assigning images to the keys Previously generated images of the default page can be used or user-defined
images can be imported using the user-defined page. They are available for
every new virtual control panel.
The user-defined images are imported by pressing the <Import> key. A dialog
is opened where the image with the extension "*.bmp" can be browsed for.
An image is displayed on the tab and can be assigned to the keys of the
virtual control panels.
The keys can be assigned in two different ways: via Drag&drop or via the
context menu if the key is located in an invisible area of the Windows Desk‐
top.
● Using Drag&drop

First, select one of the images in the "Symbols" category. Subsequently,
the key is assigned by left mouse click and dragging the cursor to the
key.

● Using the context menu
First, the key on which the image should be visible is to be selected in
the image of the control panel. Subsequently, select the image in the
category "Symbols" and right-click. A context menu with the text "Assign
bitmap to key X3Y3" is opened or in case of a freely configurable control
panel "Assign bitmap". After executing the context menu item, the image
on the desired key appears in the image of the virtual control panel.
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Fig. 6-5: Assigning images using the context menu
Assigning PLC variables to the

keys
PLC variables can be added in two different ways, as it is the case with the
emergency stop and the key-operated switch.
1. Select a PLC variable in the process variable window and drag it to the

desired key using Drag&Drop. After dropping the variable, it has to be
determined what the variable is to act on. Therefore, the key and the
corresponding LED can be selected. The name of the variable can be
seen on the configuration page in the corresponding text field.

2. Select a PLC variable from the process variable browser and drag and
drop it on the configuration page to the edit field of the PLC variable for
button or LED.
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Fig. 6-6: Configuration page of the keypads

The "button with LED" only accepts variables of type "BOOL".

VAM 40-specific configuration pages
Configuring the quick-stop module
The configuration page of the quick-stop module is opened by selecting the
quick-stop module in the image of the virtual VAM 40.

Labeling the keys In the text field "(Upper) key" und "(Lower) key", a new label can be entered
individually. It is not checked for Line breaks and line lengths. The label is
displayed immediately in the image of the VAM 40.

Function of the keys Since the keys on the real VAM 40 are hardware-wired and the switches are
equipped with normally closed and normally open contacts, these settings
have to be selected. This is implemented by setting the functions "Break-
contact" or "Make-contact".

Assigning the PLC variables There are also two different options to assign the PLC variables to the keys
and to the LED in the quick-stop module.

DOK-IWORKS-SIMU****V14-AP01-EN-P Bosch Rexroth AG 25/53
IndraWorks 14VRS Simulation

Operation in IndraWorks



1. Select a PLC variable in the process variable window and drag it to the
desired key using Drag&Drop. If the upper button is selected, a context
menu opens, for which the affiliation of the PLC variable is to be
determined. The key and the associated LED can be used for
determining the variable affiliation. There is no dialog box for the lower
button because only the button can be assigned. The name of the
variable can be seen on the configuration page in the corresponding text
field.

2. Select a BOOL variable from the process variable browser and drag and
drop it on the configuration page to the edit field of the PLC variable for
button or LED.

Fig. 6-7: Configuration page of the quick-stop module

The "button with LED" only accepts variables of type "BOOL".

VAM 41 Specific configuration pages
Configuring the eight freely configurable elements
The configuration page of the eight freely configurable elements is displayed
by selecting the rectangular checkbox or the already selected elements in the
image of VAM 41.
Under "Function of the element", several elements can be selected.
● LED
● Key with LED
● Key without LED
● Switch with 2 positions
● Switch with 3 positions

No PLC variable can be assigned to the mid-position.
These elements can be labeled and assigned to PLC variables.
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Since the keys on the real VAM 41 are hardware-wired and the
switches are equipped with normally closed and normally open
contacts, these settings can also be selected.

Labeling the elements The single elements are labeled using the "Text" field on the configuration
page. Line break and character length are again not taken into account, the
labeling is displayed immediately in the image of the VAM 41.

Function of the keys with and with‐
out LED

Since the keys on the real VAM 41 are hardware-wired and the switches are
equipped with normally closed and normally open contacts, these settings
also have to be selected. This is implemented by setting the functions
"Break-contact" or "Make-contact".

Function of the switches The PLC variable is set to logic 1 for the switch with 2 switching positions;
always depending on the switching position. The PLC variable which was
assigned to the other position is set to logic 0.
The function of the switch with three positions is identical to the switch with
two positions. The only difference is that both PLC variables are set to logic
zero in the mid-position.

Assigning the PLC variables As for the other configuration pages, there are to options to assign the PLC
variables.
1. Select a PLC variable in the process variable window and drag it to the

desired element via Drag&drop. If the element is a key with LED or a
switch, the context menu opens, for which the affiliation of the PLC
variables has to be determined. For the "Key with LED", select between
an LED and a key and for the "Switches" between the right and the left
side.

2. Select a BOOL variable from the process variable browser and drag and
drop it on the configuration page to the edit field of the PLC variable.

Fig. 6-8: Freely configurable elements of VAM 41
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The "button", "switch" and "LED" only accept variables of type
"BOOL".

Specific configuration pages of the freely configurable control panel
The freely configurable control panel has the same specific elements as the
VAM41. However, they are only partially identical regarding haptics and
name. The function and operation is identical.
The following elements are affected:
● LED round
● Key round with and without LED
● Switches with 2 and 3 positions

Configuration of the tab
On the tab parallel to the VAM 40 or VAM 41, PLC variables can be assigned
without any restrictions due to insufficient space or if they are not of type
"BOOL" and "BYTE". If a variable has been assigned successfully to an
array, the data type-dependent value field is displayed.

The current value of the variable becomes only visible in the
application and thus can only be modified in the application!

The PLC variable is assigned as follows:
Select a PLC variable in the process variable window and drag it to the
desired field via Drag&drop. The name of the variable is displayed in the text
field and the corresponding value field becomes visible.

Fig. 6-9: Configuring the tab in IndraWorks

Context menu display in the virtual control panel in the Project Explorer
The context menu is opened via Project Explorer ▶ Simulation ▶ Virtual
control panels ▶ Control panels, e.g. VAM41 ▶ Right mouse button.
The following functions can additionally be executed:

Open The virtual control panels are opened using this function.
Import... During the import the same dialog is opened as when creating a new control

panel, but the function "Create new virtual control panel" is grayed out. The
control the communication should take place with can be changed if
necessary.
Subsequently, select and acknowledge the imported configuration in the
browser using the <...> key.
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The name of the configuration file has to be provided with the
extension "*.vcp" or has to be "VirtualControlPanel_VAM40.xml"
(from version IW-Simulation-01VRS)!

Subsequently, confirm your selection and acknowledge the dialog "Create
VAM4x" or "Create virtual control panel " by pressing <OK>. If the control
panel is open at that moment, it is closed automatically; the previous
configuration is canceled and the panel is reopened with the imported
configuration.
It is checked if the configuration to be imported corresponds to the type of the
new virtual control panel. If this is not the case, the import is canceled.

Export... If the item "Export" is selected, the dialog "Export" opens. In this dialog, the
directory and the name of the file can be determined. Following the
confirmation, a copy of the configured control panel is located in the
destination directory and has the extension "*.vcp".

Assigning control... The context menu "Assign control..." is used for assigning or changing a
control. After a selection has been made, the dialog is confirmed by pressing
<OK> and the virtual control panel closes in case it has been open.
Subsequently, it is reopened automatically.

Fig. 6-10: Assigning the control
Delete When the function "Delete" is selected, the virtual control panel is removed

from the project. However, the simulation node is retained.
Rename In order to rename a virtual control panel, the context menu item "Rename"

has to be selected. Afterwards, the name may be changed in the project
explorer.

It is not checked if this name already has been used for a control
panel in the project tree. The user has to be user that the name is
unique.

Printing the configuration of the virtual control panel
Printing is executed via the General Print Component in IndraWorks
Engineering by using Main menu ▶ File ▶ Print. Furthermore, the print-out
can be previewed via Main menu ▶ File ▶ Print preview .

Printing is only possible if a virtual control panel is opened in the
foreground and is focused!

Printing the VAM40 labeling The insertion strips are printed for:
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● Key switch
● Keypad
● Quick-stop-module

Printing the VAM41 labeling The following insertion strips are printed:
● Key switch
● Keypad
● The eight freely configurable elements

Printing the labeling of the freely
configurable control panel

The labeling of the various elements is printed out successively for the freely
configurable control panel. If more than one element of one sort exists, all
elements of this type are summarized and printed out.
The labeling is printed for the following elements:
● Key switch
● Switches with 2 and 3 positions
● LED round large
● Key with and without LED round large
● Key with and without LED square small

6.1.2 Connection to the virtual control
Before the VAM Simulator can be started successfully, the following has to
be carried out to establish a connection to the virtual control:

Preparations in IndraLogic
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Fig. 6-11: Preparations in IndraLogic
● Create all variables to be connected to the VAM Simulator in "Global

variables" in the PLC program. These variables are used to actuate the
individual switching positions, keys, lamps and overrides.
They are created as follows: Variable name: BOOL, e.g. iStart: BOOL;

Addresses must not be assigned! If necessary, remove the
address assignments!

● Compile, log in and start the PLC program.

6.1.3 Start and operation
Start The virtual control panels are started via Start ▶ Program

files ▶ IndraWorks ▶ Virtual control panel or by using the icon on the desktop
"IndraWorks virtual control panel".
After the start, a project selection dialog is displayed in which the Engineering
project containing the virtual control panel has to be selected. However, this
project selection dialog can be disabled via the context menu "Show project
selection upon start". If a virtual control panel not contained in the project is
required at a later point, the virtual control panel has to be called and enabled
again via the context menu "Show project selection upon start".
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In order to keep track which IndraWorks project and control panel
is used, the title is structured as follows in the virtual control
panel:
1. Icon
2. [IndraWorks project name]
3. Control panel name
4. The application, in this case "Virtual control panel"

Fig. 6-12: Selection dialog of configurable control panels in Engineering for use
in the .exe

After the project has been selected, another dropdown box is displayed
containing the names of the configured control fields in the Engineering
project. The control panel is opened after selecting a control panel and
confirming with <OK>.

All control panels configured in the Engineering project can run in
parallel. Call the .exe again and select the control panel.

Operating the user-defined tab All PLC variables added to the configuration are write-protected and only
their value can be modified. Variables added during runtime are deleted after
closing the VAM simulator and have to be re-entered during restart.
In order not to enter the variables upon each start or to edit them in the
configuration, it is possible to remove and add the variables from/to the
configuration via the context menu.
1. Add variables to the configuration

In the context menu via right mouse button ▶ Add to configuration.
Subsequently, the variable is added to the configuration and displayed
(read-only) in the application. Subsequently, only the value can be
modified.

2. Delete variables from the configuration
In the context menu via right mouse button ▶ Delete from configuration.
Subsequently, the variable is deleted from the configuration and the
application and the text field is not write-protected anymore.

It is not queried, whether the variable should really be deleted!
The variable is irrevocably deleted from the configuration and the
application.

As for the configuration, there are two options to add PLC variables.
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1. Press the key <...> next to the PLC variable field. Subsequently, the
process variable browser is opened in which the PLC variable can be
selected. By pressing <OK>, the PLC variable is entered in the field and
the data-dependent value field shows the current value of the PLC.

2. Select one of the PLC variable fields that has not been assigned yet and
enter the PLC variables into the field.
When the field is exited, it is to be checked if the entered PLC variable
exists in the PLC. If not, it is colored in red.

The variable value is changed so that the desired value is entered in the
value field. Using the key <Enter> or by exiting the value field, the value is
sent to the PLC.

If the value range is exceeded while modifying the PLC variable
value and this is send to the PLC, an error message is displayed
and a new input has to be made!

6.1.4 Context menu in the virtual control panel
If a control panel has been started, three functions can be activated or
deactivated by using the right mouse click. In order not to reset the functions
during each restart, the functions are saved.

Fig. 6-13: Context menu display in the virtual control panel
Function "Always in the fore‐

ground"
The function "Always in the foreground" is used to ensure that the virtual
control panel remains in the foreground and is not hidden while using the
Operation Desktop. The function can be activated or deactivated any time
using the right mouse button ▶ Always in the foreground.

Function "Display diagnostics" The diagnostic display is used to show error, warning and info texts even if
IndraWorks Operation is closed. The function can be activated or deactivated
any time using the right mouse button ▶ Display diagnostics. The location for
the display is always adapted automatically.

Only the message currently pending in the control is displayed.

Function "Transparent" Using this function, the control panels can be switched to transparent to see
the application located in the background. The function can be activated or
deactivated any time using the right mouse button ▶ Transparent.

"Show project selection upon
start" function

Use the function to select whether the project selection dialog is displayed
upon the start of the virtual control panel. The selection/deselection of this
function is controlled via right click ▶ Show project selection upon start.
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6.1.5 Error messages and remedy
Error box "No virtual control panel

configured!"
Remedy: Open IndraWorks Engineering and open the project in which the
virtual user panel was configured. Select a virtual control panel using Project
node ▶ Right-click ▶ Add new element ▶ Simulation ▶ Virtual control
panels ▶ VAM40, VAM41 or create new virtual control panel or use
Library ▶ Simulation ▶ Virtual control panels to select a Virtual control panel,
e.g. ▶ VAM4x and drag it to the project node using Drag&Drop. Proceed
according to chapter "VAM 40-specific configuration pages" on page 25.

Error box "Communication could
not be established!"

Remedy: Start emulation via Start ▶ Program
files ▶ Rexroth ▶ IndraWorks ▶ MTX Emulation.

Error box "Error when writing PLC
variables"

This error message can have various reasons and thus different remedies
are available:
1. Check if PLC variables have been saved in "Global variables" and if

they are of type BOOL. Exception: Override actuation using BYTE
variables.

2. Check communication to PLC and restore the connection if necessary.
Error box "No control assigned!"
and "Incorrect control assigned!"

Remedy: Open IndraWorks Engineering and the project the virtual control
panel has been configured in. Subsequently execute: E.g. VAM40 ▶ Right-
click ▶ Assign control and select the control to communicate with. Restart the
virtual control panel.

Error box "Conversion required!" Remedy: Open IndraWorks Engineering and the project the virtual control
panel has been configured in. Subsequently, restart the virtual control panel.

Error box "Error when writing PLC
variables!"

Remedy: Open IndraWorks Engineering and the project the virtual control
panel has been configured in and the control panel. Subsequently, check
spelling of variables in the configuration and modify it if required.
Subsequently close the control panel in IndraWorks Engineering again and
restart the .exe.

6.2 Using the virtual control
6.2.1 Configuring the emulation
Restoring an existing project

General information
Short description Using IndraWorks Engineering, existing projects created at an earlier point in

time or on another computer for real systems or for the MTX emulation can
be restored.

Description This section describes how to transfer (= restore) an IndraWorks project from
a real control into the emulation. The IndraWorks project memory contains,
amongst others, the control parameters, the Profibus configuration, the PLC
program, the definition files for the M- and F-keys and the log books, as well
as the user images.
The project is restored using the function "Restore" in the menu "Project".

Handling instructions: Restoring an existing project for the MTX emu‐
lation:
This section describes how to transfer (= restore) an IndraWorks project from
a real control into the emulation.
IW-Engineering / Motion: Restore control data
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Figure Flowchart Example Instruction Documentation
Anweisung:  Restore data
Documentation: IndraWorks start-up manual Data backup

Tab. 6-1: Reference

6.2.2 Configuring the HMI
General information

Description
Short description The configured HMI data can only be used in the user interface, if they are

loaded to the runtime folder of the user interface by downloading them.
Basic conditions The runtime folder only has to be set if the installation directory of the target

control (emulation) differs from the installation direction of the source control
the project has been created on.

Handling instructions: Configuring the HMI for MTX Emulation:
These handling instructions contain notes for the settings specific for using
the MTX emulation for the HMI.
IW-Engineering / HMI BTV 40: Open and settings in the properties dialog
● Righ click on the node of the HMI device in the project navigator.

Fig. 6-14: IndraWorks project - properties
● Select the properties dialog by pressing the left mouse button on the

entry "Properties". This opens the dialog for setting the properties for the
HMI project.
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Fig. 6-15: IndraWorks project - dialog "properties"
● Enter the directory for runtime installation of the MTX (normally identical

with the installation directory of the MTX).
● Exit the properties dialog using "OK".
IW-Engineering / Project: Activate IndraWorks project
● The IndraWorks project is activated in the main menu at

"Project / Activate for operation".

Fig. 6-16: Activate IndraWorks project
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● Download the HMI project to the runtime folder by pressing the activate
command.

● The IndraWorks project will be shown after the next start of the MTX
user interface.

6.2.3 Configuring the NC Kernel
General information

Description
Brief description Restoring the IndraMotion MTX (NC kernel data) control data by using the

MTX emulation is described.
The control data can be subdivided as follows:
● Machine parameters
● System data
● Tool tables
● User FEPROM
● RAM file system
● Permanent CPL variables
● Remanent PLC data

The device communication setting have to be adjusted before
restoring the control data of a project that has been created on a
real control is possible.

Handling instructions: Restoring control data by using the MTX emula‐
tion
The handling instructions describes the steps to restore the IndraMotion MTX
control data by using the MTX emulation.
An IndraWorks project with a real IndraMotion MTX or an MTX emulation can
be the basis.

The only difference between an IndraWorks project with an MTX
emulation and a project with a real IndraMotion MTX are the
communication settings.
As soon as "localhost" is set as IP address under the
communication settings of the IndraMotion MTX device, the MTX
emulation is used for communication purposes instead of the real
IndraMotion MTX.

IW-Engineering / IndraMotion MTX: Adjust the communication settings of the
device "IndraMotion MTX".
● Use the right mouse button to click on the device node "IndraMotion

MTX". The Property dialog box of the "IndraMotion MTX" device is
opened.
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Fig. 6-17: IndraMotion MTX - “Properties” dialog
● Use the left mouse button to select the tab "Communication".
● In the entry field "IP address" select the entry "localhost" and exit the

dialog with <OK>.
IW-Engineering / IndraMotion MTX: Restore control data
● Start the IndraMotion MTX emulation via the menu item

Programs ▶ Rexroth ▶ IndraWorks ▶ MTX Emulation in the Windows
start menu (also chapter 6.2.5  "Starting and stopping the MTX
emulation" on page 42).

● Establish connection to the "IndraMotion MTX" device via the Online
switching context menu.

● Stop the PLC via the menu item Stop PLC in the context menu of the
Logic node below the MTX device node (optionally, the PLC can also be
stopped in the "IndraLogic" program).

● Call the menu item Restore... in the context menu of the MTX device
node.

● Select the desired archive in the "Restore control data archive" dialog
and initially only load the data of the "User FEPROM".

● Afterwards, finish IndraWorks Engineering and the emulation.
● Entering "14" in the DOS window finishes the emulation.
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Fig. 6-18: MTX emulation
● Restart the emulation and IndraWorks Engineering (see: chapter 6.2.5 

"Starting and stopping the MTX emulation" on page 42).
● Stop the PLC via the menu item Stop PLC in the context menu of the

Logic node below the MTX device node (optionally, the PLC can also be
stopped in the "IndraLogic" program).

● Now, select and reload all NC kernel data, except the data of the user
FEPROM already loaded.

● Complete and restart the MTX emulation and IndraWorks Engineering
again. Now, the MTX emulation uses the loaded NC kernel data.

Changed data (e.g. configuration parameters, tool data) only
become effective when completing the emulation by entering "14"
in the DOS window.

Particularities when working with the MTX Emulation
In an MTX emulation, it is not possible to execute an NC restart with a
preselected startup mode via IndraWorks. The following section describes
how these functions can be executed during the MTX emulation.

Accessing the file system of the
MTX emulation

The NC file system of the MTX emulation is accessed, as for a real
IndraMotion MTX, via the node "NC file system" below the MTX device node
in IndraWorks Engineering.
When closing the MTX emulation by entering "14" in the DOS window, the file
system of the MTX emulation is saved in several files on the PC. The RAM
file system is saved in the "typ3ram.pxf" file and the user FEPROM in the
"t3usrfep.pxf" file.

The file system of the MTX emulation is stored depending on the
version in the user directory of the registered Windows user. The
directory can be accessed via the link "_LinkToLocalAppData",
via the IndraWorks installation directory "e.g. C:\Programs
\Rexroth\IndraWorks".
The files are located in the subdirectory "MTX\Emu\".

System restart of the emulation
(startup mode 0)

A system restart of the MTX emulation is necessary to apply the changes to,
for example, the machine parameters (MACODA).
1. Exit IndraWorks.
2. Complete the MTX emulation by entering "14" in the DOS window. The

changed parameters are written to the "typ3ram.pxf" and "t3usrfep.pxf"
files on the PC and the changes will become effective upon the next
MTX emulation start.
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3. Restart MTX emulation.
4. Restart IndraWorks.

Initial program loading (startup
mode 6)

Executing the procedure of initial program loading, comparable to executing
the startup of the real MTX, with startup mode 6 re-creates the RAM file
system of the control.

The procedure of initial program loading creates a new root file
system. In doing so, all data of the old file system are deleted. If
there is an intact user FEPROM file system, the PLC boot project
and the configuration data are loaded from this system.

The procedure of initial program loading is necessary to accept changes to
the size of the tool database or the structure of the tool data sets for example.
1. If changes have been made to the tool data block, the changes have to

be copied to the "usrfep" directory of the NC file system.
2. Exit IndraWorks.
3. Complete the MTX emulation by entering "14" in the DOS window.
4. Delete the RAM file system, i.e. delete the file "typ3ram.pxf" (also see:

"Accessing the file system of the MTX emulation" on page 39).
5. Restart MTX emulation.
6. Restart IndraWorks.

Re-create the user FEPROM file
system (startup mode 7)

Re-creating the user FEPROM file system, comparable to executing startup
mode 7 of the real MTX, is necessary, if all project-specific data on a control
are to be deleted or if the user FEPROM file system is damaged.

Re-creating the user FEPROM file system results in re-creating
the user FEPROM. In doing so, all data of the old file system are
deleted. The root file system is retained. The permanent CPL
variables are deleted.

1. Exit IndraWorks.
2. Complete the MTX emulation by entering "14" in the DOS window.
3. Delete the user FEPROM file system, i.e. delete the file "t3usrfep.pxf".

"Accessing the file system of the MTX emulation" on page 39).
4. Restart MTX emulation.
5. Restart IndraWorks.

6.2.4 Configuring the PLC
General information

Description
Short description At first you have to change the communication settings of the PLC project, if

the IndraWorks PLC project is from the real control or if IndraWorks
previously has been installed in a directory deviating from the active version.
Afterwards, the PLC project can be activated.

Handling instructions: Restoring the PLC project
These handling instructions describe the steps for starting up the PLC project
that already ran on a real control.
IW-Engineering / Logic: Restore PLC project
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● Select the node "IndraMotion MTX P90\Logic" and start the "Properties"
dialog using the right mouse button.

● In the "Properties" dialog select the tab "Communication settings".

Fig. 6-19: Communication parameters of the PLC
● Press the button "Communication parameters". This opens the dialog

"Communication parameters".
● Conduct the settings shown in the following figure in the dialog

"Communication parameters" and confirm by pressing "OK". If required,
the existing old settings have to be deleted.

Fig. 6-20: Settings in the dialog "Communication parameters"
● In the dialog "Properties" (see above) open the tab "IndraLogic

directories" and adapt the directory information to the installation
directories of the emulation, if necessary. Only one directory information
may be stored.
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Fig. 6-21: Settings in the dialog "Properties/directories"
● Exit the properties dialog by pressing "OK".
● In IndraWorks use the right mouse button to click on the node "Logic"

and execute the command "Update". Now, the IndraLogic project is set
to the "Emulation" and may be restarted.

● Start IndraLogic by double clicking on the node "Logic" and translate
and download the PLC project.

Figure Flowchart Example Instruction Documentation
Documentation: IndraLogic system description Working with projects

Tab. 6-2: Reference

6.2.5 Starting and stopping the MTX emulation
General information

Description
Brief description The MTX emulation comprises both the NC kernel and the PLC that are

started and stopped together. For this purpose, a Windows application is
available. The Windows functionality during runtime can be checked via a
DOS window.
A system restart of the MTX emulation is required to, e.g. apply the changes
made to the tool data or the configuration data (also see chapter
"Particularities when working with the MTX Emulation" on page 39).

Basic conditions The MTX emulation always has to be started before starting to work with
IndraWorks Engineering (configuration interface) and IndraMotion MTX user
interface.

Handling instructions: Start the MTX emulation
These handling instructions describe how to start the MTX emulation (CNC
and PLC).
Windows: Start the MTX emulation
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● Start the MTX emulation via the menu item
Programs ▶ Rexroth ▶ IndraWorks ▶ MTX Emulation in the Windows
start menu.

● Proper startup of the MTX emulation may be identified when looking at
the feedback according to the following figure.

Fig. 6-22: Start MTX emulation

The MTX emulation always has to be started before starting to
work with IndraWorks Engineering and IndraMotion MTX.

Handling instructions: Stopping the MTX emulation
These handling instructions describe how to stop the MTX emulation (CNC
and PLC).
Windows: Start the MTX emulation
● Entering MTX emulation is completed by entering "14" in the DOS

window.

Fig. 6-23: Stop the MTX emulation

Changed data (e.g. machine parameters or tool data) are saved
only when finishing the emulation by entering "14" in the DOS
window.

Handling instructions: System restart of the MTX emulation
The content of the handling instructions constitute in the description of the
MTX emulation restart (CNC and PLC). A system restart of the MTX
emulation is required to e.g. apply changed machine data.example.
Windows: Restart the MTX emulation
● Close IndraWorks Engineering and/or IndraWorks Operation.
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● Complete the MTX emulation by entering "14" in the DOS window.
Writing the files of the RAM file system "typ3ram.pxf" and the user
FEPROM "t3usrfep.pxf" saves the changed parameters to the PC and
the changes will become effective when starting the MTX emulation the
next time.

● Restart MTX emulation.
● Restart IndraWorks Engineering and/or IndraWorks Operation.

Changed data (e.g. MACODA, tool data) only become effective
when finishing the MTX emulation by entering "14" in the DOS
window!

6.2.6 Starting the Operation desktop
Short description The MTX user interface is started as for a real application. A link is created

on the desktop when installing the MTX emulation ("IndraWorks HMI").
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7 Communication - SCP
The SCP (Scalable Communication Platform) is the standardized IndraWorks
communication platform. Any communication between Bosch Rexroth prod‐
ucts, e.g. between the virtual control panel and the PLC, is executed via
SCP.
Between the virtual control panel and the PLC the data are exchanged via
SCP items consisting of the names of the PLC variables and starting with
PLC.Pvl,.PLC variable name.
More detailed Information can be found in the SCP documentation.
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8 Service and support
Our worldwide service network provides an optimized and efficient support.
Our experts offer you advice and assistance should you have any queries.
You can contact us 24/7.

Service Germany Our technology-oriented Competence Center in Lohr, Germany, is responsi‐
ble for all your service-related queries for electric drive and controls.
Contact the Service Hotline and Service Helpdesk under:

Phone: +49 9352 40 5060
Fax: +49 9352 18 4941
E-mail: service.svc@boschrexroth.de
Internet: http://www.boschrexroth.com

Additional information on service, repair (e.g. delivery addresses) and training
can be found on our internet sites.

Service worldwide Outside Germany, please contact your local service office first. For hotline
numbers, refer to the sales office addresses on the internet.

Preparing information To be able to help you more quickly and efficiently, please have the following
information ready:
● Detailed description of malfunction and circumstances
● Type plate specifications of the affected products, in particular type co‐

des and serial numbers
● Your contact data (phone and fax number as well as your e-mail ad‐

dress)
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